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Creating a Master Project File 

The first part of this chapter provides basic concepts about a Master Project File. Later in 
the chapter, you learn how to: 

• modify existing projects, 

• apply tags, 

• create checklists using Non-Printing Text, 

• add references, 

• add hyperlinks to and from Microsoft Word documents, 

• establish the Master Project File as the default, and 

• apply the quarterly updates. 



 C h a p t e r  1 0  :  C r e a t i n g  a  M a s t e r  P r o j e c t  F i l e  

242 S p e c L i n k  U s e r  M a n u a l  

Overview 
The best way to think of a Master Project File is as a template. A template is a foundation of 
commonly used sections, text, format options, and preferences. Using a Master Project, 
you can complete a large portion of your work for a new project in much less time. For 
example, if your firm specializes in designing hospitals, you can create a Master Project 
File that contains the sections and text required for hospital buildings. Then, you only need 
to customize for the specific current project. In the same manner, if your firm likes to have a 
particular "look" for its final printed documents, you can establish the format and 
preferences in a Master Project File to ensure that all documents print the same. 

A master contains any and all changes you would make for the types of projects normally 
encountered. These "pre-edits" can consist of pre-selections of sections and/or paragraphs 
that are commonly used, as well as preferred language. 

More than one master project can be developed for different building types, different 
owners, or different code jurisdictions. You can take advantage of the concepts of Master 
Project Files by creating multiple master projects that reflect the type of projects your firm 
typically designs. 

This chapter contains information about basic and advanced features you can use when 
creating a Master Project File.  

Creating Master Project Files 
To create a Master Project File, create a new project (using either the default SpecLink 
template [master.spt] or an existing project as your Project Source), name it something that 
identifies it as a Master, and then edit the project. A Master Project File is a normal project, 
saved and kept aside as a template. 

Using Multiple Masters To Reduce Project File Size 
To minimize file size, we recommend that you create at least two masters. The first master 
would contain all your custom formatting and would have the Summary Info options filled in 
as you would always use them. The second master would contain all the sections that you 
typically use, edited as you would normally use them. When you create new projects, you 
would set the project source to the master that contains the formats, and use Import From 
Project to copy only the needed sections into the new project. Using this method, your 
projects will be the smallest file size possible.  

Methods Of Developing Masters 
Developing the master that contains the sections can be a deliberate effort or it can be 
done piecemeal over time. If you have a specifications specialist you may decide to devote 
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time to developing a master project or projects, because it saves the project teams time 
and reduces errors. Or you can build a master over time by making a note of relevant 
sections done in representative projects and copying those sections to a Master Project 
File made for that purpose.  

Whether you choose to dedicate time to creating a Master Project File or use multiple 
Master Projects, the concept is an exceptionally effective method for saving time and 
reducing errors. 

Some Types of Master Project Files 
The most common type of master project is one based on a single building type, such as a 
high-rise office building, a hospital, or a parking garage.  

You can also prepare: 

• Master projects containing custom formats for your company and for different clients. 

• Master projects containing only a few sections for highly specialized work. 

• Master projects containing only one section, edited for particular systems. Especially 
useful would be sections that are highly dependent on brand name product 
specifications, such as paint, door hardware, or any type high performance products. 

• The entire master edited for a particular code jurisdiction. 

• Short form or outline version of the entire master, by excluding paragraphs not needed 
for that version. 

• Divisions 0 and 1 only, selected and edited for particular contract types.  

NOTE: When deciding what kinds of masters you will have, keep in mind that you will 
have to update your masters four times a year when the quarterly update CD is 
installed. To streamline the process of reviewing updates, you may not want to 
include the same section in more than one master. If you do, you will have to 
review the updates twice for the same section. For more information on 
updating, see Chapter 11. 

Tactics for Developing Master Project Files 

Creating Format Masters 
If you want your projects’ headers and footers, fonts, numbering, or other formats to be 
different from the default SpecLink formats, create a master that contains the format 
changes that you need. Or, if you have clients who require particular formats, create a 
format master for each client. When you start new projects, use the format master as the 
Project Source.  
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Use the following steps to create a master that will contain custom formats: 

1. Start a new project with a name that makes it easily identifiable as a Master Project File 
that contains your company’s custom formats. 

2. Fill in the options in Summary Info with what you usually use. 

NOTE: Do not make the specific terms blank. Leave them filled in with the generic 
terms. If you delete the specific terms in Summary Info, then the places in the 
section where that text is used will be blank. The green text just will not be there. 
See Chapter 4 for more information on Summary Info. 

3. Customize the header and footer, page setup, paragraph style sets, and fonts as 
necessary to establish the custom formats that are always used. These formats will 
copy to every new project so that your projects will be consistently formatted with 
minimal effort on the spec writer’s part. 

Repeat these steps to create as many masters with custom formats as you need. 

Creating Section Masters 
Use the following steps to create masters that will contain pre-edited sections: 

1. Decide what the master project will cover: building type, location criteria, size, etc.  

2. Start a new project with a name that makes it easily identifiable as a Master Project File. 

NOTE: You may want to use your format master as the Project Source for this file so that 
if you preview sections while you are editing the master you will see how the 
section will look with your formats. 

3. Select the sections that are normally used on such a project. 

NOTE: Do not select every section that might be used since the other sections will 
always be available for use on all projects. 

4. In each section selected, select the Part 2 options that would be used on most of these 
projects. Again, don't select everything—just what is most common.  

 Select appropriate paragraphs and choose the preferred option for choices embedded 
in paragraphs. 

5. In each section, select PART 1 and PART 3 provisions to the level of completeness that 
you normally specify on projects of this type.  
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 For instance, if this is a small Master Project, you may not normally include the full 
range of Quality Assurance provisions that are available; if so, do not select those 
paragraphs. 

6. Exclude paragraphs that involve products or procedures that you never want to use (or 
want no one else to use) on projects.  

 An "excluded" paragraph status box in a newly started section becomes a "flag" 
indicating a policy decision prohibiting its use. You can also add a note in the Notes 
panel, explaining your reasons for excluding the paragraph. 

NOTE: Use exclude as a “flag” where it will be helpful, but do not exclude every section 
or paragraph that will not be used. Excluding sections and paragraphs does not 
decrease the project file size. 

7. If there are language changes needed or additional provisions that are very common, 
make or add them. 

 Also, additional provisions can be added without selecting them, making it possible to 
create options for lower probability occurrences without having them automatically 
included in new projects. 

8. Finally, make notes in the section to yourself or project team members that explain 
office procedures and policy relating to specific paragraphs, performance requirements 
or limitations, or explanations of added provisions. To add notes to a paragraph, click in 
the paragraph and then click in the Project Notes panel and type your note or paste 
from the Windows clipboard. 

 The notes you add are marked with a blue notebook icon on the right side of the “N” 
status column of the Document Panel for easy identification. Educate your team 
members about the meanings of the Note icons. Let them know that a yellow icon 
indicates a master note that may apply to the project, but a blue note should definitely 
be read. 

Using Master Project Files 
The rest of this chapter provides more information on how to edit your masters, and how to 
make one of your masters the default Project Source. Once you have created the masters, 
use them as follows:  

1. Create a new project using the desired Format Master as the Project Source. 

 The new project file will contain all the custom formats and Summary Information edits 
that were created in the selected Format Master. 

2. Use Import From Project to import the needed sections from the Section Master(s). 

 This copies all the selections, exclusions, edits, notes, custom choices, and custom 
links into the project. 
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3. Review the imported sections making required changes for this project. 

4. Note new edits that were made for the project that can be added to the Section or 
Format Masters. 

Modifying Existing Projects 
Instead of creating a master project file from scratch, re-doing research that you already 
performed for previous projects, you can incorporate the knowledge they contain into a 
SpecLink Master Project File using Import From Project to copy the sections into the 
Master Project File.  

Sections that only exist in word processing format can be imported into SpecLink using Add 
New Section From RTF File (see Chapter 4). However, if SpecLink’s master database has 
a corresponding section, it is better to edit the SpecLink section to include your preferred 
language, notes, and additional provisions. 

Use SpecLink’s master sections whenever possible so you can take advantage of the 
quarterly updates that are made to the master. Automated updating is not available for new 
content added to a section, nor will it update new sections that you create. 

Adding Text 
Here are some tips to keep in mind when adding text to your Master Project File:  

Manufacturer Names and Brand Names 
Whenever you research and approve a manufacturer for a project, add the name to the 
appropriate list in the appropriate section. If you want the manufacturer always to be on the 
list for that product category, select the paragraph. If the manufacturer is not approved for 
all instances but would be acceptable for some, don’t select the paragraph. Include a note 
indicating which product was researched and its acceptable applications. 

Add Reference Standard Citations If You Use Them  
If you use Section 01425 (or 00840 in PerSpective) to print a Consolidated List Of Citations, 
when you add text that includes a reference to another document such as an ASTM or 
ANSI standard, add the corresponding reference citation to Section 01425 or 00840. 

See the "Adding References" section in this chapter for details. 

Add and Edit Notes 
Notes are a great way to explain office procedures and policy relating to specific 
paragraphs, product usage or limitations, or explanations of added provisions. Paragraphs 
you add notes to are marked with a blue notebook icon in the “N” column for easy 
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identification. To add a note, click in the paragraph, then click in the Project Notes panel and 
type or paste your text. 

See the "Using the Notes Function" section in Chapter 5 "Editing a Project" for details about 
adding project notes, and see the “Adding Checklists” section of this chapter for detail on 
adding pictures.  

Add Hyperlinks to and from Related Documents Created in Microsoft Word 
You can paste large amounts of text into your project notes, but it may be more convenient 
to create hyperlinks to Word documents that contain the note. This is also helpful if the 
information in the note is likely to be changed periodically. The hyperlink will always point to 
the same document even when the information changes. 

See the "Adding Hyperlinks" section in this chapter for detailed information on adding 
hyperlinks to and from Word documents. 

Don’t Copy Text Just To Move It  
If you do, updates that would otherwise apply to the text do not take effect.  

See the "Copying and Pasting" section in Chapter 5 "Editing a Project" for details about 
moving paragraphs.  

Importing From the Clipboard 
The use of Import from Clipboard and Add New Section From RTF File can be valuable, 
timesaving features. You can take previous work from a word processor and import it into 
SpecLink.  

See the “Add New Section from RTF File” section in Chapter 4 and the "Importing From the 
Clipboard" section in Chapter 5 "Editing a Project" for details.  

Copy and Paste 
SpecLink takes advantage of the hierarchical nature of the standard document format and 
the paragraph relationships in the Copy and Paste functions.  

See the "Copying and Pasting" section in Chapter 5 "Editing a Project" for details.  

Promote and Demote 
Once you have imported text or copied and pasted text, you might find that the paragraphs 
are not at the hierarchical level that you want. Use the Promote and Demote commands 
from the Document menu or on the Document Panel toolbar to change the paragraphs to 
the correct level. 
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See the "Demoting and Promoting Paragraphs" section in Chapter 5 "Editing a Project" for 
details. 

Add Links and Choices 
Add links to automatically select relevant options. Add choices that list common options and 
have fill-ins for users to enter information that is different for a particular project. 

See Chapter 6 for information on adding links. See Chapter 5 for information on adding 
choices.  

Apply Tags  
If you use the requirements reports, apply tags to paragraphs in new sections that you 
would like listed in the requirements reports. 

For more information on applying tags see the “Applying Tags” section in this chapter. 

Add Checklists 
Checklists can be used to select and edit sections. Add checklists to your master project so 
that users can “check off” what is required for a project. Create links from the items in the 
checklists to automatically select, highlight, and exclude appropriate information. Apply the 
Non-Printing and Non-Selectable tags to the checklist so that they will not print in the final 
documents. You can add checklists as separate sections in the master, and/or within 
existing sections. You can also add pictures to items in the checklist to illustrate the 
choices. 

See “Adding Checklists” later in the chapter for more information. 

Hide Excluded Text 
When you are creating a Master Project File, you can make the project appear less busy 
by hiding excluded text. You can use Compact and Expert View to view the project in the 
manner you want, although you should only use Master View while editing, adding, or 
deleting paragraphs. 

See the "Changing Views and Previewing" section in Chapter 5 "Editing a Project" for 
details about view options. 

Project Settings 
In the master that contains your formats, set the printing format and project defaults to 
those most commonly used. This includes all the Project Summary Information settings 
(except the project name and project ID), the page layout, headers and footers, paragraph 
formats, and font formats.  
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See Chapter 8 "Printing" for details about these settings and format options.  

NOTE: Review Chapter 4 "Creating a New Project" to learn about global settings you 
can use in your Master Project File. 

Protect Your Master(s) From Accidental Edits 
Since users on a network must have full access (read, write, edit, and delete) to projects in 
order to use them as the Project Source and to copy sections from them using Import From 
Project, setting limited rights to these files on a network is not a feasible way to protect your 
master files. Try these methods instead: 

• Change file extension to .spt: The only file extensions that can be opened and edited in 
SpecLink are .spp. and .prs. Files with the extension .spt can only be selected as the 
Project Source. Masters that you only use as the Project Source (not ones that you 
need to use Import From Project to copy from) can be protected if in Windows Explorer 
you change the extension from .spp or .prs to .spt. You and others will only be able to 
open and edit these files if they change the extension back in Windows Explorer. 

• Keep backups of your masters where no other users can access them and where you 
will not accidentally open and edit them. Compare the Modified dates of these files in 
Windows Explorer from time to time. If the date of the file that everyone has access to 
changes, try to determine if it was a valid edit. You can open the master and view the 
dates and times on the section titles in the tree panel to determine which section was 
edited. If the file was edited in error, replace it with a copy of the backup. 

Review The Updates To The Master  
When you receive a new CD-ROM, open the master project file(s) and review and accept 
the updates before starting new projects.  

See the "Updating” chapter 10 for details. 

Using Tags 
The list of available tags can be seen by clicking the arrow on the Tags button on the 

Document panel toolbar . 

Tags have three functions in SpecLink: 

• Requirements Reports: When a paragraph is tagged with a requirement tag, if that 
paragraph is active, the paragraph’s section will be listed when that requirements 
report is printed. For example, if a paragraph states that Shop Drawings are required, 
the paragraph should be tagged SD for Shop Drawings (if you add the paragraph 
yourself you would have to apply the tag as described later). When that paragraph is 
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active in the section, that section will be listed in the Shop Drawings requirements 
report. (See Chapter 8 for more information on requirements reports and a full list of 
requirements tags.) 

• References and Related Sections: In Part 1 General of each BSD master section the 
References and Related Sections articles are tagged “RT” and “ST” respectively. 
Subparagraphs under these articles are tagged ”RS” and “RE” respectively. These 
tags interact with the options in the Summary Information dialog box, “Include Citations 
in Each Section” and “Include Related Sections.” Based on the selection of these 
options, if a subparagraph of References or Related Sections is active, the article 
(References or Related Sections) will or will not become active by a green link. This 
allows you to choose to include those articles in every section, but only when there 
actually is a Reference or a Related Section in the section. (See “Adding References” 
later in this chapter for more information.)  

• Checklists: When combined with links, the “NP” (Non-Printing) and “NS” (Non-
Selectable) tags allow you to add checklists to your projects that select, highlight, or 
exclude appropriate information. (See “Adding Checklists” in this chapter for more 
information.)  

NOTE: You may see two or three additional tags in the Tags status column that are not 
listed in the Tags button. Tags that are not listed on the Tags button are ones that 
are used just by BSD for our master database. KW means keyword, MT is for 
manufacturer list titles, and UM is an obsolete tag that has been replaced by the 
ML tag.  

Applying Tags 
To view what tags are applied to paragraphs do one of the following: 

• To view tags paragraph by paragraph, click to place your cursor in the paragraph and 

look at the Tags button, which is the last button on the Document panel toolbar . 
It will display the two-letter code for the applied tag. 

• To view tags for all paragraphs, click the Show Tags button on the toolbar , or from 
the View menu choose Display Layout and then choose Tags. The “T” column will 
display the two-letter codes for the tags to the left of the text in the Document panel. 

To apply a tag to a paragraph or to change the tag that is applied to a paragraph: 

1. Click to place your cursor in the paragraph. 

2. Click the arrow on the Tags button . The list of tags will open. 

3. Click on the appropriate tag in the list. 

To apply the same tag to additional paragraphs: 
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1. Click to place your cursor in the paragraph. 

2. Click on the Tags button  (Not the arrow). The same tag will be applied. 

NOTE: To see a listing of all available tags, while in SpecLink+, click on Help | Use Index 
for Help. Type in Tag, and select the topic called Complete List of Tags. 

Adding References 
To handle reference citations for added paragraphs in the same manner as references are 
treated in the master, add them this way:  

1. Add a paragraph in the body of the section that contains a new reference. 

2. If you use the References article in Part 1, add a paragraph for the reference containing 
the full citation. Tag the paragraph RS (Reference Text Segment). 

 See the previous section of this manual for information on applying tags. 

3. If you use Section 01425 (or 00840 in PerSpective) to create a Consolidated List Of 
Citations, and if this is a brand new reference, add a paragraph in Section 01425 or 
00840, containing the full citation.  

4. Create links from the paragraph in the body of the section to the paragraph you added 
under the References heading in Part 1, and to the corresponding citation in Section 
01425 or 00840. 

 See Chapter 6 for information on adding links. 

Adding Checklists 
Checklists are created using three SpecLink features: 

• Non-Printing tags: NP – Non-Printing and NS – Non-Selectable (SpecLink Only) 

• Links 

• Adding pictures to notes 

You can add paragraphs with questions and answers, add pictures to the question and 
answer paragraphs to illustrate the options, and then add links from the answers to the 
appropriate sections, paragraphs, and choices. You make the questions and answers non-
printing by applying the “NP” and “NS” tags. These tags allow the paragraphs to be active 
yet not print. (Remember that source paragraphs must be active in order to activate links to 
targets.) 
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Sample Checklists 
A number of checklist sections are provided in the SpecLink tab as examples of what can 
be done in an office master using SpecLink’s Checklist features. To see some of these 
sections, open any project and view sections 01815BSD, 05515JSL, 08211BSD and 
15062MIR. The sections are best viewed with the Document Panel and Master Notes 
Panel on, and the Tree Panel and Project Notes Panel off.  

NOTE: Checklists are being added to new sections as time allows. 

These checklists consist of a short series of options that precedes the master specification 
text. All the paragraphs in the checklist part of the section are tagged either as NS (non-
selectable) or NP (non-printing). None of these specially tagged paragraphs will print with 
the resulting specification section. The NS paragraphs also are not selectable. They are 
automatically selected by relevant links from the selectable (but non-printing) paragraphs in 
the checklist. Ultimately, links connect the checklist options to the specification text, 
resulting in a specification section that is pre-edited by choices made in the checklist. 

NOTE: To see what tags are applied to paragraphs, turn on the Tags status column. 
From the View menu choose Display Layout, and then choose Tags. 

Perhaps the most dramatic feature of the checklists, however, is the information that 
appears in the notes attached to many of the checklist paragraphs. The sample checklists 
use HTML files which include photos, diagrams, and other graphics that clearly illustrate the 
available options. Other supported file types, along with directions for using them are listed 
below. 

Adding Non-Printing Text 
Where you put the non-printing text is entirely up to you. If you want the checklist to apply to 
the entire project, you could either make a new section that only consists of questions and 
choices, or add the questions and choices at the beginning of the Table of Contents. You 
can also add non-printing text at the beginning of sections to help edit the section, or just 
before a list of choices within a section. The point of a checklist is to help the user 
determine what text to include in the specification based on the questions and answers.  

To make a checklist: 

1. Make new paragraphs, typing in the text that belongs in them - questions, answers, 
directions, etc. 

2. For paragraphs that are questions or directions that you do not want users to be able to 
accidentally de-select, apply the tag NS (non-selectable). 

3. For paragraphs that are answers that you do not want to print, but you do want users to 
be able to select, apply the tag NP (non-printing). 
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4. Build links from the answers to the appropriate sections, paragraphs, and/or choices. 

 For directions on building links, see Chapter 6. 

Text with the tags NS or NP will not print in the final specification. 

Tips On Adding Checklists: 
When deciding how to add checklists to your master, keep the following tips in mind: 

• If you apply NP to a section title, not only will the section not print, but it will also not be 
listed in the Table of Contents report. 

• If you apply NP or NS to a paragraph that has sub-paragraphs, you will be required to 
let SpecLink apply the NP or NS tag to the children as well. Be careful when you do 
this, because if you did not mean to apply the tag to ALL the subparagraphs, you have 
to remove the tags one by one. 

Adding Pictures to Notes 
Pictures in notes are graphic or HTML files that display in the master notes panel. You can 
add pictures to any paragraph that does not already have a master note. If you want to add 
a picture to a paragraph that does have a master note, you can create a new paragraph 
next to it, tag the new paragraph NS or NP, and add the picture to it.  

NOTE: The pictures cannot be printed from SpecLink.  

Requirements for Adding Pictures to notes 
In order to add pictures, there are several guidelines that must be followed: 

• Supported file types: .html, .htm, .jpg, .bmp, .png, .gif. 

• You can only display one file per paragraph. To display multiple pictures with or without 
text, create an .html or .htm file that contains all the pictures and text. If you do not have 
an HTML editor such as FrontPage, you can do this in your word processing program 
by choosing File … Save as Web Page. If you do not have Save as Web Page, then 
choose File … Save As and change the Save As Type to .html or .htm. 

• The picture files must be saved in the Wizards folder that is in the same location as 
your local Master Database Location. To see what your Master Database Location is, 
close all open projects in SpecLink, then from the File menu choose Permissions. Click 
the System Settings tab. The Master Database Location is the second field. 

• To organize the pictures in the Wizards folder, you can create subfolders. 

• In order for another user to view the pictures in the project from his or her own 
computer, the picture files must be saved in the Wizards folder that is in the same 
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location as the local Master Database Location. If you created subfolders under the 
Wizards folder, the other user will need to have the same folders. 

How to Add Pictures to notes 
To add pictures to notes: 

1. Save the picture files in the Wizards folder that is in the same location as your local 
Master Database Location as described in the requirements above. 

2. Click in the paragraph that you want to add the picture to. 

NOTE: The paragraph cannot already have a master note. If it does have a master note, 
create a new paragraph and add the picture to it. 

3. Click in the Project Notes panel. 

NOTE: If you cannot see the Project Notes panel, from the View menu choose Project 
Notes. 

4. Type the location of the picture file starting with the folder it is in under the Wizards 
folder. 

 For example, to enter the location for a file named hinge.gif that is saved in a folder 
named Hardware inside the Wizards folder, you would type: 

   Hardware/hinge.gif 
 If the hinge.gif file were located directly in the Wizards folder, then you would type: 

hinge.gif. 

NOTE: While you can use copy and paste to copy the name of the file, thereby ensuring 
that you spell it the same way, be careful that you are not copying the file itself. 
To copy the name of the file, in Windows Explorer click once on the name of the 
file, wait, and then click again on the name of the file. The name will turn blue 
indicating it is in ‘edit mode.’ While the name is still highlighted, use CTRL+C to 
copy the name. Then use CTRL+V or Paste to paste the name into the Project 
Notes Panel. 

5. Click on a different paragraph to save your edit. 

6. Click back in the paragraph where you added the note. 

 The picture displays in the master notes panel. 

NOTE: If you cannot see the Master Notes panel, from the View menu choose Master 
Notes. 
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 If the picture does not display, verify that you typed the path and filename correctly, 
verify that it is a supported file type as listed above under requirements. 

Adding Hyperlinks To Word 
You can create hyperlinks from any paragraph in SpecLink to a related document in Word. 
Now, instead of pasting a lengthy document into a SpecLink project note, you can create a 
hyperlink at any paragraph that will automatically open Word and the associated document. 

Establish Root Directory Path For Hyperlinked Word Documents 
The first thing you need to do is to establish the root directory path for all documents that 
will be hyperlinked to SpecLink. Typically, this path would be a folder on the network drive 
where SpecLink is installed. If several people will be using your master project file, the root 
directory path must be one that all users can follow; otherwise they will not be able to open 
the linked documents. To establish the root directory path for Word documents that will be 
linked to your office master project, follow these steps: 

1. Using Windows Explorer, create the folder where all hyperlinked documents will be 
stored. For simplicity, we suggest you establish a subfolder under your SpecLink folder. 

2. In SpecLink, close all projects, then from the File menu, click on Permissions. When the 
dialog box opens, click on the System Settings tab. 

3. The last setting on the System Settings tab is Root Directory Path for Linked 
Documents. Click on the browse icon for that setting and find the folder you created in 
Step 1. Click OK, and the root directory path should appear in the setting. Click Apply 
and then OK. 

4. Using Windows Explorer or Word, place each document that will be linked to the master 
project file in the folder you created under Step 1 before you create a hyperlink to that 
document. 

Adding Hyperlinks 
Once you have placed a Word document in your linked document folder, you are ready to 
create a hyperlink in SpecLink that will automatically open the document. To create a 
hyperlink, follow these steps: 

1. In your office master project, open to the appropriate section and scroll to the paragraph 
where you want the hyperlink. 

2. If the Document Link (DL) status column is not visible, on the View menu click on 
Display Layout and then on Document Links. The DL column opens. 

3. Open Windows Explorer and find the document to which you want a link. Click on the 
document and hold the left mouse button down, then drag the icon from Explorer and 
drop it in the DL column at your source paragraph. The link is created and a Word icon 
appears. 
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Status Columns Showing Icons for Hyperlinked Word Documents  

If you point to an icon without clicking, a balloon will appear with the file name of the linked 
document. Subsequently, all you have to do to activate the hyperlink is to click once on the 
Word icon. If Word is closed, clicking once on the icon opens Word and then opens the 
hyperlinked document.  

NOTE: Each user must establish the root directory path for linked documents in the 
Permissions dialog box, which allows the program to find the linked documents. 

Removing Hyperlinks 
To remove a hyperlink you created: 

1. In your SpecLink project, locate the paragraph that has the link you need to remove, 
and click in the paragraph. 

2. From the Document menu, choose Remove Document Link. 

3. A message opens to confirm that you want to remove the link. Choose Yes. The Word 
icon will be removed from the DL column. 

Setting the Default Project Source 
When you start new projects, you can use your format master as the Project Source. You 
can change this each time you start a new project as described in Chapter 4. Or, as 
described in this section, you can set the project source to default to your format master. 
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To set the default project source: 

1. Close all open projects, but leave SpecLink open. 

2. From the File menu, choose Registration and Settings. 

 The Registration dialog box opens. 

3. Click the Systems Settings tab. 

 

Registration and Settings dialog box, system settings tab 

4. To the right of the Template Database Location, click the yellow folder. 

 The Open dialog box opens. 
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Open dialog box 

5. Navigate to and select the appropriate format master. 

6. Click Open. 

 The System Settings dialog box reopens with the Template Database Location set to 
the new file. 

7. Click Apply and then OK. 

8. To test the change, from the File menu, choose New Project. 

 The New Project dialog box opens with the Project Source set to the file you selected 
for the Template Database Location. 

Handling Updates 
If you have one or more Master Project Files, someone in your office should be assigned 
the responsibility for updating them before any new projects are started. If you start a new 
project by copying the Master Project File before it has been updated, the new project will 
have to be updated subsequently in a separate operation. For details on specific updating 
procedures, see Chapter 11 "Updating."  

 


